Please note: Guidelines change. Please follow the current guidelines and template. DO NOT use a former student’s thesis or dissertation as a guide for formatting.
Table of Contents

Introduction ........................................................................................................................................ 2  

  Template, Guidelines, and The Graduate School Website .......................................................... 2  
Research Compliance .................................................................................................................... 2  
Use of Copyrighted Material .......................................................................................................... 3  
Previously Published Material ..................................................................................................... 4  
Required Text for Previously Published Materials ....................................................................... 5  
Writing Styles ................................................................................................................................... 6  
Document Structure ....................................................................................................................... 6  
Page Numbers ................................................................................................................................ 8  
Text, Spacing, Margins .................................................................................................................... 11  
Tables and Figures .......................................................................................................................... 12  
Horizontal Pages ............................................................................................................................ 13  
Documentation of Sources ............................................................................................................ 15  
Preliminary Draft ............................................................................................................................ 15  
Final Requirements ......................................................................................................................... 16  

  Survey of Earned Doctorates (Doctoral only) ............................................................................. 17  
General Information ....................................................................................................................... 18  

  General Questions ......................................................................................................................... 18
Introduction

This guide is designed to help students present the results of their graduate studies and research for completion of either the Master’s Thesis/Recital Document or Doctoral Dissertation. The manuscript is intended to demonstrate the student’s ability to conduct, document, and communicate the results of independent research. While the content is left to the discretion of the student and their Supervising Committee, formatting standards are established by The Graduate School.

Template, Guidelines, and The Graduate School Website

Q. Does The Graduate School have a template or any other formatting information?
   A. Yes, we offer a template, formatting workshops, preliminary draft formatting review, and more. Read over the materials provided on the Thesis/Dissertation webpage and download the Formatting Template and the Preparation Guidelines. You are strongly encouraged to attend a formatting workshop or webinar. All information can be found here: http://graduateschool.utsa.edu/current-students/category/thesis-dissertation/

Q. Where can I find the template and what formats are available?
   A. You can locate the template and preparation guidelines on this page: http://graduateschool.utsa.edu/current-students/formatting-requirements/

   The template is available in MS Word and LaTeX/LyX formats.

Q. I am in the Biomedical Engineering joint program. Is there a separate template for me?
   A. Yes, there is a separate MS Word version of the template for Biomedical Engineering students. At this time, there is not a separate LaTeX template for BME students. If you are using LaTeX, please also download the Word BME template and pay close attention to the changes on the Title Page and the Abstract reflecting the joint program.

Research Compliance

RESEARCH PROJECTS CANNOT BEGIN UNTIL ALL APPLICABLE COMPLIANCE APPROVALS HAVE BEEN OBTAINED.

The University of Texas at San Antonio Office of Research Integrity and Compliance (ORIC) reports to the Vice President for Research and provides oversight and support for the responsible conduct of University research. This includes facilitating comprehensive regulatory guidance, providing educational activities, monitoring compliance, and the development, distribution and implementation of written policies, procedures, and standards of conduct that support adherence to institutional policies and applicable federal, state, and local laws and regulations.

ORIC areas of oversight and support include the Institutional Review Board (IRB) and the use of human subjects in research; the Institutional Animal Care and Use Committee (IACUC) and the use of animals in research; the Institutional Biosafety Committees (IBC/rDNA, IBC/Chemicals);
the Conflict of Interest Committee; Export Control issues; Time and Effort Reporting; and training in the Responsible Conduct of Research (RCR).

Visit the ORIC online: http://research.utsa.edu/oric/

**How it works:**

Required *Application forms* needed for requesting permission to use humans, animals, or any other compliance-related areas in your research must be completed. The completed forms are submitted to the ORIC for review and approval. Please allow two to three weeks for this process. Upon successful review, an official approval letter will be issued to you.

**Where to find the Application Forms:**

- The **Human Subjects** application is currently located on the Research Integrity and Compliance website: http://www.utsa.edu/oric/irb/

- The application for use of **Animals** is currently located on the Research Integrity and Compliance website: http://www.utsa.edu/oric/iacuc/

- The **Biosafety** application is currently located on the Research Integrity and Compliance website at: http://www.utsa.edu/oric/ibc/

*NOTE:* These forms and a copy of your approval letter must be included in an appendix to your thesis/dissertation when it is submitted to The Graduate School and must follow all required formatting guidelines, including a page number at the bottom center and the appropriate margins. The easiest way to include the IRB letter is to insert it into your Word document as an image (either scan the hard copy of the letter or save the PDF as an image file). If you have questions about how to format these forms within your appendix, please contact the Thesis/Dissertation Officer for help.

If you have questions about completing the forms or other questions on approval for your study, please contact ORIC.

### Use of Copyrighted Material

#### Permission for Use of Previously Published Material

If any of the material in the Master’s Thesis/Recital Document or Doctoral Dissertation has been published, the student must obtain written permission from the copyright holder (typically the publisher) giving the student authorization to use the material in the manuscript. A copy of this permission must be submitted to the Thesis/Dissertation Officer.

In ordinary practice, it is generally assumed that the quotation of a prose passage of approximately 150 words or less in a work of scholarship or criticism does not require written permission of the copyright owner (but must be in quotation marks with the proper citation...
given). However, the area of “fair use” of copyrighted materials can be defined only by court action, and existing precedents are insufficient to make an exact or strict definition of its limits. Style manuals provide further discussion of “fair use.”

Should the student decide that it is necessary to obtain permission from the copyright holder, the usual procedure is to write the owner and obtain a written authorization for use of the material (a.k.a. copyright permission). Ordinarily, the only condition for use is that proper acknowledgment be made.

If the student has already previously published any portion of his/her Master’s Thesis/Recital Document or Doctoral Dissertation material, written authorization from the journal(s) must be obtained before the material is used (see next section “Previously Published Material” for more details).

A copy of the permission to use copyrighted material must appear in an appendix to the Master’s Thesis/Recital Document or Doctoral Dissertation.

Software owned by company or corporation is protected under U.S. law. It is illegal to use, in whole or in part, any software, design, and/or documentation in any activity, including research, publications, university papers, assignments, or theses without prior written permission from the company or corporation.

Previously Published Material

Subject to the approval of the student’s Supervising Committee, the student has the option to include as part of the Master’s Thesis/Recital Document or Doctoral Dissertation the text of an original paper or papers that have been or will be submitted to journals in the field.

The inclusion of manuscripts co-authored by the candidate is acceptable, but the student is required to make an explicit statement on who contributed to such work and to what extent. The Master’s Thesis/Recital Document or Doctoral Dissertation must conform to all requirements explained in this guide.

Any manuscript containing journal papers, prepared in the manuscript format, must include a preface. In addition, the Acknowledgements section of the Thesis or Dissertation must include the full text of the two italicized paragraphs listed below in the “Required Text for Published Material” section.

Contents

The Master’s Thesis/Recital Document or Doctoral Dissertation must be more than a mere collection of manuscripts published or to be published. It must have an overall title; it may also have subtitles. It must include a comprehensive abstract, a full introduction and literature review, and final overall conclusion, which interprets the results of the research and describes the contribution to the field. Where the student is not the sole author of a manuscript, the introductory material to the chapter comprised by the manuscript must explicitly describe the
student’s contribution to the work and acknowledge the contributions of the other author(s) of the work. Connecting texts, which provide logical bridges between different manuscripts, are necessary in the interest of cohesion.

Additional material, including procedural and design data as well as descriptions of equipment, must be included in sufficient detail to allow a clear and precise judgment to be made of the importance and originality of the research reported. This material is usually included as an appendix to the document.

**Formatting Published Materials**

The styles used in manuscripts previously published or submitted for publication may follow the styles required by the journals; thus, styles may differ among parts of the Master’s Thesis/Recital Document or Doctoral Dissertation. The pagination, margins, spacing, and type size of the parts, however, must follow the guidelines for the traditional Master’s Thesis/Recital Document or Doctoral Dissertation (see Arrangement and Pagination section of this guide). The preliminary pages will be the same as for the traditional Master’s Thesis/Recital Document or Doctoral Dissertation.

In most cases, manuscripts of previously published materials must be retyped to conform to the type size, margin, and legibility requirements of the traditional Master’s Thesis/Recital Document or Doctoral Dissertation. Pages of those chapters should be numbered consecutively with the rest of the Master’s Thesis/Recital Document or Doctoral Dissertation. Photographs or other materials which do not duplicate well from reprints or scans must be included in their original form.

If you are unsure whether your document follows the required formatting, please contact the Thesis/Dissertation Officer.

**Required Text for Previously Published Materials**

The first page of the published chapters should have an asterisk (*) next to the title. When copies of papers already published are used as separate chapters, connecting texts are mandatory and supplementary explanatory material is almost always necessary. Please include a statement beneath the chapter title indicating that the material has been previously published, the name of the journal, when it was previously published, and the names of any co-authors.

The following two paragraphs shall be cited on the Acknowledgements page of any Master’s Thesis/Recital Document or Doctoral Dissertation which includes work that has been previously published. These paragraphs should be single-spaced and italicized.

“This Master’s Thesis/Recital Document or Doctoral Dissertation was produced in accordance with guidelines which permit the inclusion as part of the Master’s Thesis/Recital Document or Doctoral Dissertation the text of an original paper, or papers, submitted for publication. The Master’s Thesis/Recital Document or Doctoral Dissertation must still conform to all other requirements explained in the “Guide for the Preparation of a Master’s Thesis/Recital Document..."
or Doctoral Dissertation at The University of Texas at San Antonio.” It must include a comprehensive abstract, a full introduction and literature review, and a final overall conclusion. Additional material (procedural and design data as well as descriptions of equipment) must be provided in sufficient detail to allow a clear and precise judgment to be made of the importance and originality of the research reported.

It is acceptable for this Master’s Thesis/Recital Document or Doctoral Dissertation to include as chapters authentic copies of papers already published, provided these meet type size, margin, and legibility requirements. In such cases, connecting texts, which provide logical bridges between different manuscripts, are mandatory. Where the student is not the sole author of a manuscript, the student is required to make an explicit statement in the introductory material to that manuscript describing the student’s contribution to the work and acknowledging the contribution of the other author(s). The approvals of the Supervising Committee which precede all other material in the Master’s Thesis/Recital Document or Doctoral Dissertation attest to the accuracy of this statement.”

Writing Styles

In addition to adhering to the requirements explained in this guide, each student should consult with the style manual that is normally used in their discipline. Should one not exist, please consult with the most current edition of A Manual for Writers of Term Papers, Theses, and Dissertations by Kate L. Turabian. A copy of this book is available in the UTSA Library. Having decided upon the methods of research presentation and the mechanics of form, please remember to be accurate and consistent throughout your document.

Document Structure

Below is the required structure and organization for the Master’s Thesis/Recital Document or Doctoral Dissertation. Use the template on The Graduate School’s website to see correct formatting and spacing for the following pages: Signature Page, Title Page, and Abstract.

1. Signature Page

   Q. I have a different number of committee members than what is shown on the template. What do I do?
      A. Add or remove lines as needed.

   Q. Should I add the Dean’s name to the bottom line?
      A. NO – do not add the Dean’s name to the bottom signature line. This should read “Dean, Graduate School” as shown on the template.

   Q. Is the top line for the chair of my committee or the chair of my department?
      A. The chair of your committee.
Q. On the template, it says “First Name Last Name, Ph.D.” under each line. What does this mean?
   A. This is the format in which you should type your committee members’ names under each line. For example, “Dr. John Smith” is not acceptable; it should be written “John Smith, Ph.D.”

Q. Do I need to have my signature page signed?
   A. No. As of Spring 2014, submitting two printed copies is no longer a final submission requirement. Because of this, your signature page will not be signed and will be uploaded unsigned to ProQuest.

Q. Since signature pages are no longer signed, how is my document approved by my committee?
   A. Doctoral students: Your dissertation is approved by the Certification of Completion of Dissertation Requirements for Doctoral Degree form. This form is one of the required doctoral forms; there is no change to this policy. Your college will route this form to us for the Dean’s signature. This form should be received by The Graduate School no later than the final deadline.

   Master’s students: Your thesis is approved by the Certification of Completion of Thesis Requirements for Master’s Degree form. This form should be signed once you complete your defense. Your College will route this form to The Graduate School for the Dean’s signature. This form should be received by The Graduate School no later than the final deadline.

2. Copyright Page (optional): Copyright protection automatically subsists from the time the work is created in fixed form and immediately becomes the property of the author who created it. Registration with the U.S. Copyright Office is not required to secure copyright. It is a legal formality to place on the public record the basic factors of a particular copyright. The notice of copyright appears as the sole item on the page immediately following the signature page. The student’s name must appear as it is on file in the Registrar’s Office. If you choose not to register the copyright, please delete the copyright page from your final document.

3. Dedication Page (optional)

4. Title Page

5. Acknowledgments

6. Abstract

7. Table of Contents: The table of contents should accurately reflect the outline and the organization of the manuscript. It should include the abstract, acknowledgements, list of tables, list of figures, chapters of the text, appendices (if present in document), references, and vita.
8. **List of Tables (required if tables are in document)**

9. **List of Figures (required if figures are in document)**

10. **Manuscript Text:** The text should be divided into as many chapters or sections as necessary.

11. **End Notes (if present):** If you choose to include End Notes in your document, they will appear after the last page of your text. Continue numbering with Arabic numerals.

12. **Appendices (if present):** Appendix material must meet the same formatting requirements as the rest of the document. Reduction of materials to meet margin requirements is acceptable only if the print remains clear and legible. Appendices appear before the references.
   - If you have an approval letter from the IRB, it must be included in an appendix.

13. **References**

14. **Vita**

**Page Numbers**

<table>
<thead>
<tr>
<th>SEQUENCE</th>
<th>PAGINATION</th>
<th>PAGE NUMBER PLACEMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signature Page</td>
<td>Not counted/No page number</td>
<td>None</td>
</tr>
<tr>
<td>Copyright (optional)</td>
<td>Counted if included/No page number</td>
<td>None</td>
</tr>
<tr>
<td>Dedication (optional)</td>
<td>Counted if included/No page number</td>
<td>None</td>
</tr>
<tr>
<td>Title Page</td>
<td>Counted/No page number</td>
<td>None</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lower case Roman numerals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledgements</td>
</tr>
<tr>
<td>Abstract</td>
</tr>
<tr>
<td>Table of Contents</td>
</tr>
<tr>
<td>List of Tables &amp; List of Figures</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Arabic numerals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text (Chapter 1, Intro. or Preface)</td>
</tr>
<tr>
<td>Endnotes (if present)</td>
</tr>
<tr>
<td>Appendices (if present)</td>
</tr>
</tbody>
</table>
How to set up page numbers in Word:

The best way to make sure your page numbers are correct is to download and use the formatting template provided on our website: http://graduateschool.utsa.edu/current-students/formatting-requirements/. If you lose the page number formatting that appears in the template, you can set up all page number sections manually. Remember, you will have multiple page number sections (no page numbers, Roman numeral page numbers, Arabic numeral page numbers, and the Vita) in your document. The following page includes instructions for setting up all sections of page numbers in your document.

Make sure your page numbers are placed in the bottom center of the page, regardless of your writing style. Page numbers should never appear in a corner of the page.

If you continue to have trouble setting up your page numbers after following the instructions on the next page, please contact the Thesis/Dissertation Officer for guidance.

These instructions are for Microsoft Word. If you are using Word for Mac, menus may be in different locations than in the PC version. For example, Word for Mac users will select the “Insert” menu rather than the Page Layout menu.

Adding Roman Numeral Page Numbers:

1. Check to see if you already have a section break in place between the title page and acknowledgements page. Double-click the footer of the title page. If it states “Footer – Section 1” and the header on the Acknowledgements page says “Header – Section 2,” you already have a section break. Skip to step #5 below. If these numbers are the same or if no section number is given (i.e. it just says Footer and Header), you need to create a section break. Continue to the next step.

2. Click on the bottom of the title page (not the footer, just at the bottom after all text).

3. Go to the Page Layout menu. Select Breaks, then Section Break – Next Page. You have now created a section break.

4. Double-click the footer of the acknowledgements page to open it.

5. In the Header/Footer Tools menu, turn OFF the button that says “Link to Previous.” If this button is already turned off, skip to the next step.

6. Add your page numbers. In the Header/Footer Tools menu, go to Page Number. Add page numbers to the bottom center of the page.

7. If necessary, go back to the Page Number option and select “Format Page Numbers.” From here, you can tell your page numbers to be lower case roman numerals and to begin counting at iv.

8. If needed, delete page numbers from the signature page through title page.
Adding Arabic Numeral Page Numbers (beginning on the first page of your text):

1. Check to see if you already have a section break in place between the last roman numeral page and the first page of your document text. Double-click the footer of the last Roman numeral page (typically the List of Figures). If it states “Footer – Section 2” and the header on the first page of your text says “Header – Section 3,” you already have a section break. Skip to step #5 below. If these numbers are the same or if no section number is given (i.e. it just says Footer and Header), you need to create a section break. Continue to the next step.

2. Click on the bottom of the last Roman numeral page (not the footer, just at the bottom after all text).

3. Go to the Page Layout menu. Select Breaks, then Section Break – Next Page. You have now created a section break.

4. Double-click the footer of the first page of your text page to open it.

5. In the Header/Footer Tools menu, turn OFF the button that says Link to Previous. If this button is already turned off, skip to the next step.

6. Add your page numbers. In the Header/Footer Tools menu, go to Page Number. Add page numbers to the bottom center of the page.

7. If necessary, go back to the Page Number option and select “Format Page Numbers.” From here, you can tell your page numbers to be Arabic numerals and to begin counting at 1.

Removing the Page Number from the Vita:

1. Check to see if you already have a section break in place between the last page of your references section and the Vita. Double-click the footer of the last page of your references. If it states “Footer – Section 3” and the header on the first page of your text says “Header – Section 4” (these numbers may differ from document to document), you already have a section break. Skip to step #5 below. If these numbers are the same or if no section number is given (i.e. it just says Footer and Header), you need to create a section break. Continue to the next step.

2. Click on the bottom of the last page of your references (not the footer, just at the bottom after all text).

3. Go to the Page Layout menu. Select Breaks, then Section Break – Next Page. You have now created a section break.

4. Double-click the footer of the Vita to open it.

5. In the Header/Footer Tools menu, turn OFF the button that says Link to Previous. If this button is already turned off, skip to the next step.

6. Delete your page number.
Text

- The manuscript text should be **black**.
- **Times New Roman** and **Arial** are acceptable. Students are to use **12 point fonts** within the body of the text.
  - You may set chapter titles and other main headings at either 12pt or 14pt. If you choose to set main headings at size 14, be consistent: if one main heading is 14pt, all main headings in your document must be 14pt.
  - You may set your text at 10pt for endnotes, footnotes, and Table/Figure titles and descriptions. Again, be consistent if you choose to do this. For example, if one table/figure title is 10pt, all table/figure titles must be 10pt.
- **Remove all hyperlinks** that are in the text and in the bibliography. To do this in Word, right-click on the link and select “Remove Hyperlink.” This will convert your link to plain text. If the student wishes to go beyond the set font sizes, they must consult with the Thesis/Dissertation Officer in The Graduate School.

The final copy must be a professional quality manuscript, correct in spelling and punctuation, and neat in format.

Spacing

The Master’s Thesis/Recital Document or Doctoral Dissertation must be double-spaced or one and a half spaced throughout, with the exception of the dedication, quotations, lengthy tables/figures, and footnotes. Entries in the bibliography, Table of Contents, List of Tables, and List of Figures may be single-spaced within each entry, so long as a space is inserted between each entry (see references section in template for example of this spacing).

Margins

The margins must be set to the following values throughout the entire document:

- Left margin: 1.25”
- Top margin: 1.25”
- Right margin: 0.75”
- Bottom margin: 0.75”

All page numbers should be centered on the bottom. The page number should be 0.5 inches from the bottom edge of the page.

**These margins are required throughout the entire document, including pages containing tables, figures, or other illustrative materials.** All tables and figures must sit inside the margins.
The Graduate School will measure your margins to be sure your document follows the correct guidelines.

**Tables and Figures**

Tables and figures should bear their identifying numbers and headings on the pages upon which they appear. Labels should include the word “Table” or “Figure”, the number of the table/figure and the title.

- Tables are labeled *above* the table; Figures are labeled *below* the figure.
- If a table or figure requires more than one page, the subsequent pages must be labeled as continued. For example: “Table 1: Continued” or “Figure 1: Continued”

**Continuing table example:**

**Continuing figure example:**
The numbering style (Table 1, Table 2, and so forth vs. Table 1.1, Table 2.1 and so forth) will be determined by your writing style.

Examples:

Table 1: Title Typed Here

<table>
<thead>
<tr>
<th>example</th>
<th>example</th>
<th>example</th>
</tr>
</thead>
<tbody>
<tr>
<td>example</td>
<td>example</td>
<td>example</td>
</tr>
<tr>
<td>example</td>
<td>example</td>
<td>example</td>
</tr>
<tr>
<td>example</td>
<td>example</td>
<td>example</td>
</tr>
</tbody>
</table>

Figure 1: Title Typed Here

Horizontal Pages

Horizontal (landscape) tables and figures must be positioned correctly: the top of the figure or table will be against the *left* margin. Figure captions and table headings should be placed in the same horizontal direction as the figure or table. Page numbers in Microsoft Word must be moved by hand to appear in the correct portrait-style position.

**How to format landscape pages in your Word Document:**

A. For landscape pages, the pagination must stay the same as your portrait-style pages and your margins must be set correctly. Landscape page numbers must be *manually* placed in the portrait page number position.

1. Inserting a landscape page should automatically create a section break. If it does not, follow the instructions for removing the Vita page number (refer to page 5 of this document) to create a section break.
2. Double-click on the footer of the first landscape page. In the header/footer tools menu, turn off the button that says “Link to Previous.”
3. Double-click on the footer of the first portrait-style page that follows your landscape page(s). Turn off the “Link to Previous” button for this page as well. Your sections are now unlinked.
4. Delete the page number from your landscape page(s).
5. Insert a text box and type in the correct page number.
6. In the Text Box Tools menu:
   a. Make sure the text box has no border or fill color.
   b. Click the Text Direction button until your page number is facing the correct direction as seen in the example below.
7. Drag the text box to the left side of the page. Your landscape page and page number should now look like this:

8. Make sure your margins are correct. Landscape pages will have different margins than portrait-style pages:
   Top = 1.25”   Left = 0.75”   Bottom = 0.75”   Right = 0.75”
9. Make sure the next portrait-style page has the correct formatting. Double-check your margins (use the portrait-style margins listed on page 4 of this document) and make sure the page number continues counting correctly.

Avoiding Landscape Pages:
   One way to avoid the formatting above is to save an image of your table or figure and rotate the image on a portrait-style page rather than rotating the page itself. If you do

<table>
<thead>
<tr>
<th>Table 1 - Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>101</td>
</tr>
<tr>
<td>102</td>
</tr>
<tr>
<td>103</td>
</tr>
<tr>
<td>104</td>
</tr>
<tr>
<td>105</td>
</tr>
<tr>
<td>106</td>
</tr>
<tr>
<td>107</td>
</tr>
<tr>
<td>108</td>
</tr>
</tbody>
</table>
this, insert your table/figure title in a text box and rotate the text so it faces the same direction as the rotated image. This eliminates the need to adjust margins and manually adjust page numbers.

Tables and figures, including maps and illustrations, should be prepared to facilitate binding and preservation. Oversized charts and graphs may be reduced in size to fit within the appropriate margins; however, this reduction must not seriously degrade the readability or usefulness.

If you need to include oversized material (large maps, charts, or anything that does not fit within the required margins of the document) in your document, these materials will be submitted electronically to ProQuest as “supplemental material.” Supplemental material will appear in a pocket in the back of the ProQuest bound copies, typically burnt onto a CD, and will be accessible electronically when the thesis/dissertation is viewed online. For more information, please contact the Thesis/Dissertation Officer.

Documentation of Sources

References - All manuscripts must have references. The “References” section contains a list of texts explicitly cited in your manuscript. Follow your chosen style manual. Your references may also be titled “Bibliography” or “Works Cited” according to your writing style.

End Notes/Foot Notes - Depending on your chosen style, you may use footnotes, endnotes, or in-text parenthetical references that correspond to a reference list at the back of your manuscript. Endnotes and footnotes may be numbered either sequentially from the beginning to the end of the text, or within each chapter.

Preliminary Draft

A preliminary draft is a rough draft of your thesis or dissertation. Submitting a preliminary draft to The Graduate School for a formatting check is strongly recommended. This draft may or may not be 100% complete. Preliminary drafts are typically submitted prior to your defense.

Preliminary Draft Process

1. Schedule an appointment with The Graduate School to review your document with a Thesis/Dissertation officer. You can schedule an appointment by calling (210) 458-4331 or emailing gradengage@utsa.edu. Please keep the following in mind when preparing your draft:
   - Preliminary drafts should be submitted as printed copies.
   - Print on regular copy paper
   - Print single-sided
   - Do not staple or bind your document

2. At your appointment, the Thesis/Dissertation Officer will go over the following:
   - Revisions
Please keep in mind that The Graduate School does not read the content of your document, but checks the formatting against our required formatting guidelines. This means that we do not check your citations, spelling, or grammar, or review your document for plagiarism. If you are unable to have a preliminary draft check in person, or if you have questions about the preliminary draft process, please contact the Thesis/Dissertation Officer.

**Final Requirements**

The Graduate School has the following requirements:

1. ProQuest
2. Survey of Earned Doctorates (*Doctoral candidates only*)

**Printed Copies**

As of spring 2014, printed copies are no longer required. Please do not submit printed copies to The Graduate School; the UTSA Libraries are no longer accepting hard copies for binding or archival. Your ProQuest submission now serves as the university’s archival copy.

**ProQuest Electronic Submission (Masters & Doctoral)**

Students are required to submit one electronic copy of their manuscript to the ProQuest website. The ProQuest submission must be completed by 5:00 p.m. on the final deadline. More information on the required ProQuest submission can be found here: [http://graduateschool.utsa.edu/current-students/proquest/](http://graduateschool.utsa.edu/current-students/proquest/)

**Q.** Does it cost anything to submit electronically through ProQuest?
**A.** There is no fee to submit your document to ProQuest. Any charges are associated with optional add-ons offered through ProQuest. These include the copyright registration ($55.00), Open Access publishing ($95.00), and bound copies (prices vary). All three of these items are optional.

**Q.** Should my ProQuest signature page be signed? In other words, do I need to scan a signed copy of my signature page for ProQuest?
**A.** No. When you upload electronically through ProQuest, signatures will not appear on the signature page; it will be unsigned, just as it appears on your computer. **DO NOT** include scanned signatures. You will be asked to remove the signatures and re-upload your document with an unsigned signature page.

**Q.** Is registering the copyright mandatory?
**A.** No, registering the copyright is optional. Copyright registration is offered through ProQuest when you submit your electronic copy. You must decide if you are registering
the copyright prior to submitting your final copies to the Graduate School. If you do register the copyright, the fee through ProQuest is $55.00 and the copyright page from the template must be included in your document. If you choose not to register the copyright, please delete the copyright page from your final copies.

For more information on copyright, please visit ProQuest’s resources page: http://www.etdadmin.com/cgi-bin/main/resources

Q. Can I buy bound copies of my thesis/dissertation?
A. Yes, ProQuest offers the option to purchase bound copies for your personal use. The University does not offer personal binding services. This is one of the final options offered to you during the ProQuest submission process. You are not required to buy bound copies, but they are available if you are interested.

Survey of Earned Doctorates (Doctoral only)

This survey is required for doctoral candidates only. The survey must be completed online no later than 5:00 p.m. on the final deadline. More information on the survey can be found here: http://graduateschool.utsa.edu/current-students/doctoral-requirements/

Q. What is the Survey of Earned Doctorates?
A. The Survey of Earned Doctorates (SED) is a federal agency survey in which UTSA participates, conducted by NORC for the National Science Foundation and five other federal agencies. The SED gathers information from new doctoral graduates about their educational histories, funding sources, and post-doctoral plans.

Doctoral students must complete the online SED by the final deadline. This is not the survey you complete when you apply for graduation. The link to complete the SED can be found on our website: http://graduateschool.utsa.edu/current-students/doctoral-requirements/

Q. Do you have all of my doctoral forms?
A. In order for doctoral students to be cleared to graduate, we must have all completed doctoral forms on file. You may ask to review your file with the Thesis/Dissertation Officer during your preliminary draft meeting. Your department is responsible for routing the completed forms through your College and to The Graduate School for the Dean’s signature. More information on doctoral forms is available here: http://graduateschool.utsa.edu/faculty-staff/doctoral-forms/
General Information

Registration

Q. Do I need to be enrolled in thesis/dissertation hours during the semester I will defend and submit my final thesis/dissertation?
   A. Yes, you are required to be enrolled in thesis/dissertation hours during the semester you defend and submit your document to The Graduate School. See the Graduate Catalog for more information.

Common Problems

Q. I’m not able to defend prior to the final deadline. Will you accept my final thesis/dissertation on the deadline day without a defense?
   A. No, we will not accept a thesis or dissertation without a defense. You must defend before you can submit a final draft of your thesis or dissertation to The Graduate School. We suggest you allow two weeks between your defense and the final deadline to allow time to make any revisions required by your committee.

Q. I need to graduate this semester, but I also need additional time to complete my final document. I won’t be able to meet the final deadline. What can I do about this?
   A. If you need to discuss the deadline, please contact the Thesis/Dissertation Officer before the final deadline to review your situation.

Q. Can you help me distribute personal bound copies to friends/family/my department since I live out of state?
   A. No. You are responsible for distribution and handling of any personal bound copies you choose to order.

General Questions

Q. When should I defend my thesis or dissertation?
   A. The Graduate School recommends that you defend at least two weeks before the final deadline in order to allow adequate time to make revisions. Please work with your committee to schedule your defense.

Q. I cannot make it to your office during business hours. How can I meet with the thesis/dissertation officer?
A. Please email the thesis/dissertation officer to discuss options for reviewing your document. We are happy to work with you to ensure your formatting is checked.

Q. Where can I find the deadline to apply for graduation?
   A. You can find this deadline on the Graduation Coordination website: http://www.utsa.edu/registrar/graduation.cfm

Q. I submitted my thesis/dissertation to The Graduate School, but my grade is still RP. When will my official grades show?
   A. The Graduate School does not assign grades for your thesis or dissertation. For questions regarding grades, you should contact your advisor or supervising professor. You may also contact the Registrar’s Office at (210) 458-8000.

Q. Do you require appointments, take walk-ins, etc.?
   A. We accept walk-ins, but you are strongly encouraged to email or call ahead to schedule an appointment to ensure the Thesis/Dissertation Officer is available to meet with you.